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3. BIOS 5% E

ARt A A2 0k EEPROM ZCIE#E (R4 BIOS fit 25 - BIOS( Basic Input/Output
System) JEEpm M d Bl Rl ACE 2 R Mos sy —TERE R o UETERSE IR - SHTHHRRRA -
SRR "Run Setup” BUBERING 8 BRI E] BIOS BUE - AREHTR A BIOS AL
HHIBCEVIRE ©

{ERAPIMZ % - BIOS RS HBAE R AL I - AClRBS A mbtaa s YRS -
PRESS DEL TO ENTER SETUP

WFSEEAESEEEIEZATAL > Fte<Clrl> + <Alt> + <Del>FAREMPHH - 802 T BRY
Reset §f - A {ERHGERITE T2 BRIEEAEIRL » T RER B TBA -

1T <Del>$itft » EHTHBRIBIATT -

Phoenix - AwardBIOS CMOS Setup Utility

SoftMenu Setup

Standard CMOS Features
Advanced BIOS Features
Advanced Chipset Features
Integrated Peripherals
Power Management Setup

PnP/PCI Configurations

» PC Health Status
Load Fail-Safe Defaults
Load Optimized Defaults
Set Password
Save & Exit Setup

Exit Without Saving

Esc: Quit
F10: Save & Exit Setup

T« : Select Item
(NF-CK804-6A61FA1FC-00)

Change CPU’s Clock & Voltage

X RTIBEASREMERER  HANW I EME S RENEERN BIOS EIH - AFMAMSIHI
BIOS e B REMESEMA » TR GAEEER LAMRIINTERMER -
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3.1 SoftMenu Setup (CPU £%7F)

Phoenix - AwardBIOS CMOS Setup Utility
SoftMenu Setup

AMD Athlon(tm) 64 Processor 3000+ Item Help
Frequency : 1600MHz
CPU Operating Speed Default
x - CPU External Clock (MHz) 200
x - PCIe Clock 100MHZ
Voltages Control Default
- CPU Core Voltage 1.250 v
x - DDRII RAM Voltage 1.80 Vv
x - DDRII REF Voltage 0.9v
x - PCIe Voltage 1.50v
x - CPU VDDA Voltage 2.5V
x - HyperTransport Voltage 1.2 v

tl-«:Move Enter:Select +/-/PU/PD:Value Fl0:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Brand Name
SE{FE H g CPU [RIBE &5 -

Frequency
SEMHTE B SR CPU PSR IRAER -
CPU Operating Speed

S 1L AR BR8P R B 5 o M SR S - St T L User

Define] (HEI-EREE ) HSEEACT Byl AFSEI SR -

User Define :

¥ EERETHERNEAREUURINDRIK - E AR IR R RGN - s IIAX
RENEE PCI BAANERERCHAR  HEEHRALEREETERIF - ZLE
- FHRENRAR - B R LEAERRERERNN R ILAERERSERIRERZEREL - &
LRHAHCHRE  BEREIRARC L » MUSERR—BERREZT -

¥ BAIHRBHRRLSONZREER - MEEMRE - RIBRERMER TSR TTHREEE
Emis®  FRAIMSEE-

- CPU External Clock(MHz)

SEMEEERE CPU RYSMETRE « SZIRHA T ZZEry CPU Btk » Rfas E it i H A HE M R e

HEE SR HAANRES -
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- PClIe Clock
ILIE I 354 PCI Express I IRITE -

Voltage Control

S (ST P LA T TR A o 8 S PR« ol e R SR A i e » PR I
T - AHIEHH ITEZ M - " User DefmeJ JJI ST TLA%??E?ET%JHU P A -

- CPU Core Voltage

- DDRII RAM Voltage

- DDRII REF Voltage

- PClIe Voltage

- CPU VDDA Voltage

- HyperTransport Voltage

3.2 Standard CMOS Features ({Z# CMOS 2H:®7T )

Phoenix - AwardBIOS CMOS Setup Utility
Standard CMOS Features
Date (mm:dd:yy) Wed, Aug 2 2006 Item Help
Time (hh:mm:ss) 12 : 34 : 56
» IDE Channel 1 Master None
» IDE Channel 1 Slave None
» IDE Channel 2 Master None
» IDE Channel 2 Slave None
» IDE Channel 3 Master None
» IDE Channel 4 Master None
» IDE Channel 5 Master None
» IDE Channel 6 Master None
Drive A 1.44M, 3.5 in.
Drive B None
Floppy 3 Mode Support Disabled
Halt On All, But keyboard
Base Memory 640K
Extended Memory 1047552K
Total Memory 1047552K
ti-+:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Date (mm:dd:yy)
safEEEEL [HT~ [HT ~ PUse [#F] mukg=laeefafa e H] GaE 2B HE) -

Time (hh:mm:ss)
SEMEEEEL IR~ [3] ~ DU [B0] A CoREsoE S P Aainsia] GRS ZBUERIR ) -
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% IDE Channel 1/2 Master/Slave, IDE Channel 3~6 Master:
## <Enter> #AfcHE AT ¢

Phoenix - AwardBIOS CMOS Setup Utility
IDE Channel 1 Master

IDE HDD Auto-Detection Press Enter Item Help
IDE Channel 1 Master Auto

Access Mode Auto

Capacity 0 MB

Cylinder 0

Head 0

Precomp 0

Landing Zone 0

Sector 0

tl-+:Move Enter:Select +/-/PU/PD:Value F1l0:Save ESC:Exit F1l:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE HDD Auto-Detection
IESEIE A P EFE I T <Enter>3288 A (531 IDE 242 » S5 b2 ey B R ER L - -

IDE Channel 1/2 Master/Slave, IDE Channel 3~6 Master

ERER [Auto] (%@J) K7 » BIOS ey H Wit A A (5 FHIRERY IDE 25 - ANS A B Ak
ﬁgfg%gmgﬁ RHEGES [Manual] (F8)) - I HHEE IR —TES AT RN EE -
A A S &F‘&Fﬁﬁﬁmf LR SO AR RER YRR E -

Access Mode

SEfEE H R IDE SEERIEHURE - FHT H TR E [Auto] (HB)) RIRCE - 7% BIOS HE)
Mo AR AR A AP R T AT

Capacity

SEfE e H PR R  ERA ?j(Tfﬂ Pt T LR AR ) A B S R hA AR A AR =P
TR AR AR A

Cylinder
s {5 H A REREA g -
Head

SE AR H AH ARG SR B -
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Precomp
S flATE H B ] DA B ATk s e

Landing Zone

SEfEH H TR TR B > SR TGRSR I s,

Sector
SEMEE H AR — IR S 8 E -

% [E%] Standard CMOS Features (fE#: CMOS 2835 ) HE = :

Drive A/Drive B
e P B T SRS IR 2 A RS ) =X -

Floppy 3 Mode Support
SEFE E A A2 e A AR B IS S i f T3 Mode Floppy DnveJ FEPT DU BRI A ~ B 82

Both (Wi HI) = AIFAENZ A A H AR R RE S ar{d I HTHRE [Disabled] ([
P BIRCERRTLAT ©
Halt On

SE A H T RAE B RAAE BB T RS R A R 2 5 B 1L RAR AT E -

[All Errors] : RAfiBAEAR FrlF Erfs 1 - BV BIOS (s HIRIFRE g -

[No Errors] : ZifBHHEIE 771 & IR RS AL RS A B 52 L

[All, But Keyboard] : 5/ Bt 5 i & X B L SERR S AR T 11 B T SO $ERR LIS -
[All, But Diskette] : =ARFHHIR P& KIS AE I SERR BRI 11 BT RERR FrASERRLL

e
[AN, But Disk/Key] : SR 71 G115 (F S4B ATBITT (1 - B 7 R ol
FIBEARLAS.

Base Memory

SE A H SRR e SERISERERC IR R A ) - SERERC IRRE AT B2 SUIRY 640K HIRMRLIERE -
II1E 640K B3 2 284 E AR ERVRCISIE A -

Extended Memory
TEEME H BRI AR 7 e 2 AR TR AR ) -

Total Memory
Sa {5 HEURH R AT ] R R R/ -

KN9 3-5

Flks so1d



3.3 Advanced BIOS Features ( BIOS 3&EPETHREERE )

Phoenix - AwardBIOS CMOS Setup Utility
Advanced BIOS Features

Quick Power on Self Test Enabled Item Help
» Hard Disk Boot Priority Press Enter

First Boot Device Floppy

Second Boot Device Hard Disk

Third Boot Device CDROM

Boot Other Device Enabled

Boot Up Floppy Seek Disabled

Boot Up NumLock Status On

Security Option Setup

MPS Version Ctrl For OS 1.4

Delay IDE Initial (Secs) 0

Full Screen LOGO Show Enabled

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Quick Power On Self Test

HRGER [Enabled] ) )IRf - & {lHH HAERA AR IR 2 4% - FINE POST (Power On Self Test)
HIREST - BIOS &/ POST ifE & i sUe Bl —tepm A i ] -

Hard Disk Boot Priority

[T ] A SR B R (BRI BB R R <Enter> iz » 1Al DIE A S TS5 > Cari
TR R ] DGR S B e A R » DU ARSI 247
[HLIEThRE(E HAE First/Second/Third Boot Device & Hi{T{af—{3E H4G [Hard Disk] F55E0EmE 5

First Boot Device / Second Boot Device / Third Boot Device / Boot Other Device

£ [First Boot Device] ~ [Second Boot Device] Lk [Third Boot Device] HYZE H & - sl =
55—~ 55 LIRS IEFT BRI AL - BIOS I er kIR EH IR - (KIS F A B
FA - AR E T =SSR DA SEE ARBAKIRE - G [Boot Other Device] (A&
Ptk EErs [Enabled] (&) -

Boot Up Floppy Seek

EROERy [Enabled] () I - BIOS Kt dxlK it A 228 s 5204 -
Boot Up NumLock Status

S I DR B A AR BRI I TR IRTE -

[On] : B P R AR -
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[Off] : St FH T 1F A -

Security Option

e fEVE HE R SRR SR — SRR O A BIOS BER «
[Setup] : LG5t A BIOS 2% Iy 78 A1 -

[System] : 7GSRI A\ B0 -

X TEETECRENER  B—TiLT » ColEFE—& » fTRMR - BBER CMOS &
RER + ZAUEHRE - MEFTERESERNERR » LRV ABENRE R -

MPS Version Ctrl For OS

,_{I SETES e TS & SR MPS (Multi-Processor Specification ) s o g iy S IE
S ©

Delay For HDD(Secs)

FEHFERSLACTERF A > SE {5 H st BIOS Soff—th g i B2 RiRRY IDE 2808 - MOARYBE ] LA
PEAGHEE S RAVIEEIRFE] > DIRE A B Ehe B -

Full Screen LOGO Show
SEMEMEE JUE BRI S S B R B R -

3.4 Advanced Chipset Features ( & #EPETHRE 2 BIEE T )

Phoenix - AwardBIOS CMOS Setup Utility
Advanced Chipset Features

HT Frequency Auto Item Help
HT Width 116 116
» DRAM Configuration Press Enter
SSE/SSE2 Instructions Enabled
System BIOS Cacheable Enabled

tl{-9+:Move Enter:Select +/-/PU/PD:Value F1l0:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

HT Frequency
I e o g LA B DA 2 IR LDT VR RS -
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HT Width
I3 H g o B s B LA o iz iy LDT RESTHRS -

DRAM Configuration
% <Enter> $AHE A +H7H -

RERT DA FHIE SR TIH 2 T B%s DRAM FIRELA - sloe i {7 (E DRAM iR SPD (51
FEhE) FR ERVTHERGEOE

Phoenix - AwardBIOS CMOS Setup Utility
DRAM Configuration

DRAM Timing Selectable Auto Item Help
x - DRAM Clock DDRII 533
x - DQOS Timing Training Skip DQS
x - CKE Base Power Down Mode Enabled
x - CKE Base Power Down By Channel
x - Memclock Tri-Stating Disabled
x - TwTr Command Delay 2 Clocks
x - TrfcO for DIMM1 75 ns
x - Trfcl for DIMM2 75 ns
x - Trfc2 for DIMM3 75 ns
x - Trfc3 for DIMM4 75 ns
X - Write Recovery Time (Twr) 4 Clocks
x - Precharge Time (Trtp) 2 Clocks
X - Row Cycle Time (Trc) 17 Clocks
x - RAS to CAS Delay(Trcd) 4 Clocks
x - RAS to RAS Delay(Trrd) 2 Clocks
x - Row Precharge Time (Trp) 4 Clocks
X - Min. RAS Act-Time (Tras) 12 Clocks

- CAS Latency Auto

- Command Rate Auto

Memory Hole Remapping Enabled

DRAM ECC Enable Disabled
x - DRAM MCE Enable Disabled
X - Chip-Kill Mode Enable Disabled
x - DRAM ECC Redirection Disabled
x - DRAM Scrub Rate Disabled
x - L2 Cache Scrub Rate Disabled
x - DCache Scrub Rate Disabled

Auto Optimize Bottom IO Enabled
x - [31:24] IO Space EO

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% [E1Z] Advanced Chipset Features (5 #HERSTIRESBENE ) HIESE
H:

SSE/SSE2 Instructions

ARIEAZE TEnable | (&)=t " Disable | ({5 ])SSE/SSE2 (Streaming SIMD Extensions)i¥j$54y
£ (instruction set) - THZ{EES " Enable | (&) -

System BIOS Cacheable
[P H R I Eeds FHERIGR AR BIOS » DU RS T3
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3.5 Integrated Peripherals (24iBi25%F)

Phoenix - AwardBIOS CMOS Setup Utility
Integrated Peripherals

» OnChip IDE/RAID Function Press Enter Item Help
Init Display First PCI Slot
OnChip USB V1.14v2.0
- USB Keyboard Support os
- USB Mouse Support os
OnChip Audio Controller Auto
OnChip LAN Controller Auto
- OnChip LAN Boot ROM Disabled
Onboard FDD Controller Enabled

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% OnChip IDE/RAID Function
1% <Enter> $HEA R THIH ¢

Phoenix - AwardBIOS CMOS Setup Utility
OnChip IDE/RAID Function

» IDE Function Setup Press Enter Item Help
» RAID Configuration Press Enter

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help

F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults
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% IDE Function Setup
1% <Enter> $HEAF T-HIH ¢

Phoenix - AwardBIOS CMOS Setup Utility
IDE Function Setup

IDE 1 Controller Enabled
IDE 2 Controller Enabled
IDE DMA Transfer access Enabled
OnChip SATA Controllers Enabled

Item Help

tl{-+¢+:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:General Help
F5: Previous Values F6: Fail-Safe Defaults

F7: Optimized Defaults

IDE 1 Controller
JE MR n] DU RSB BOZBAPH IDEL #5025 -

IDE 2 Controller
s I A DUE R AP B2 FR IDE2 EHI2% -

IDE DMA Transfer access

BETAH AT A IDE Sisi iz 261E .2 DMA 5z -

OnChip SATA Controllers
I3 H A I B ] o adt SATA $Efiles -
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% RAID Configuration
1% <Enter> $HEAF T-HIH ¢

Phoenix - AwardBIOS CMOS Setup Utility
RAID Configuration

RAID Function Disabled Item Help
x - IDE 1 Master RAID Disabled
x - IDE 1 Slave RAID Disabled
x - IDE 2 Master RAID Disabled
x - IDE 2 Slave RAID Disabled
X - Serial-ATA 1 RAID Disabled
X - Serial-ATA 2 RAID Disabled
X - Serial-ATA 3 RAID Disabled
X - Serial-ATA 4 RAID Disabled

tl{-+¢+:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

RAID Function

BEHH frat v ez RAID THRE -

- IDE 1 Master/Slave RAID ~ IDE 2 Master/Slave RAID
BEHH frat e H o5 ] IDE 12 szt By RAID DIRE -

- Serial-ATA 1 RAID ~ Serial-ATA 4 RAID

BRI H A s H 5= Serial-ATA 1~4 iR Fir) RAID LjEE -

% [@%] Integrated Peripherals (34&58:83%5%) WEXER

Init Display First
PR e L SR R -

OnChip USB

s USB Pl as iR -

- USB Keyboard Support

1EA 4% USB SRRy EE (28R (ELaiEk DOS) 2 T - Ffe [BIOS] (FHA%fE) -
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- USB Mouse Support
TEARSEE USB 1Bl es R (LLanas DOS) i F - i [BIOS] (THafH) -

OnChip Audio Controller
TE (I BRI BB PH A A R il

OnChip LAN Controller

SE (I EEBEE BB A LAN £EdilEs -

- OnChip LAN Boot ROM

SEEPEH AR B ROM (FHLIABEIGERE ) ARBHIHE ARAR - it H AT DU S I s s -

Onboard FDD Controller
& I FE T B BB PRI 2 25 -
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3.6 Power Management Setup ( EREPIENXEE )

Phoenix - AwardBIOS CMOS Setup Utility
Power Management Setup

ACPI Suspend Type S3 (Suspend-To-RAM) Item Help
- USB Resume from S3 Enabled
Power Button Function Instant-Off
Wake up by PME# of PCI Disabled
Wake up by Onboard LAN Disabled
Wake up by Alarm Disabled

x - Day of month Alarm 0

x - Time (hh:mm:ss) Alarm 0:0:0
Cool’n’Quiet Technlogy Auto
Power On Function Button Only

x - KB Power ON Password Enter

x - Hot Key Power On Ctrl-F1l
Restore On AC Power Loss Power Off

tl{-+¢+:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1l:General Help

F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

ACPI Suspend Type

S flETE R AR R -

[S1(PowerOn-Suspend)] : i Power On Suspend IHEE -
[S3(Suspend-To-RAM)] : i Suspend to RAM LJjEE

- USB Resume from S3

e [Enabled] () ) I » 550 i JuF i il USB 45 4aeie S3 (STR - Suspend To
RAM) kit - LU EE T ACPI Suspend Type  Etife [S3 (STR) ] i » iafdmiH
FHEE LM -

Power Button Function
SEMETE H R ACE R AR B IRRRA =

[Delay 4 Sec.] : Fpig it t R UL ol PP SR RTRSRARA R IRBR - 38 R LARG A&
AN HHEE SR N AR ISR AR RARAT AR IR -

[Instant-Off] : & N AEFRPHFE I — K - @R & LB PH RAR AR -

Wake up by PME# of PCI

5 [P (Enabled)] K5 > (EAAIFI PCI - _EAYFFHENEESRHE ML Y Soft-Off JIREE YR
# o % PCL R ARIAIRLIRE -
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Wake up by Onboard LAN

S (PR (Enabled)] 1% » (FAMPyE LAN It FAEIUII AR BRI S Soft-Off JRAE 1) 7%

Wake up by Alarm

HEERS [Enabled] () W » ] DASEE BT S LUK A (Soft-Off ) #E = B bl &y
HEALAUR SR » EMMZLL T Date (of Month) Alarm | [/ f; " Time (hh:mm: ss) Alarm o H9IE
EIRMEE « ANEUURT » ISR RARATILRCE R BTE AR TR EOR S (S /W Isis )
WBEEFFIENE » SRR EE S AAE AR FE B S » DU B i -

- Day of Month Alarm
[0]: BLEEXERE rIfkiEAE T Time (hh:mm:ss) Alarm 35 H e B IIRFHESR R R A BRI BHAET

[1-31]: phsesER n s AR SR R AR FR IRBH R H T - SR (e ATa ﬁmH A AR TR
b - 3l HLAAE Time (hh:mm:ss) Alarm 35 H HrFfTas & BRR ] A ) 2

- Time (hh:mm:ss) Alarm
[P TR A A R SR AR FR BT IRR (] -

Cool 'n’ Quiet Technology
L SETE AT DABA RS o S BEER AMD K8 vl K i shhe

Power On Function
LSRR AR R A B R R B B 5 = o

[Password] : {f 155 ACBIE AR + SR IILSIFA A T <Enter> Heg 4 A L5
5 - (2 MDA (57T » SRAAFTHA 52— BTG - Bt N <Enter> B AeHeRRI Y
fe -

[Hot KEY] : i 1] <F1>H|<F12> rRBT—{E ) RER A R I -
[Mouse Left] : Sy B /- R B R B I

[Mouse Right] : ##s El A HA B R A B IR

[Any KEY] : { F{T-— (B AR BRE RA FR IR -

[Button Only] : {5 FH TR IR SRR B R AR -

[Keyboard 98] : {i#f "98 BLfg | MG LAY TEIFIZ SR B R IR -

¥ MERER PS/2 BERTRRIRIEAITHEE - TIMEMEM COM B3R USB AIXMBR
B PS/2 BRAEKRMIRE - RRTMEEAM CHMNE - IRCERNOAKEANEE
HEE + R ATRBSEAS R EIRBRRK

- KB Power On Password
[P SR T T R A R RS B T T S R 515
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¥ BAESE Y ENES - BRIERLEER CMOS i BERFTANSE - DURtEE Rt ER
ItEThEE -

- Hot Key Power On
3& fE2E H rI R RE Hh RIRp s T <Crrl>3g N AT —EShEst(<F1> ~ <F12>)BHE R

Restore On AC Power Loss
[ SRR A R AR YRR (R AR B -

[Power Off] : EA AR IR AL RITE LI - RRAMEIFRIRISHERHERIPARDINGE - T N HEERE
B LABRE RAEFR A -

[Power On] : FARFRIRISCIEEE AL - AR SIS H BB -
[Last State] : &2y BIRIAAGRIE UL - SRR & RUR BB IR A BTHIARTE - ANRRAE

FEAR IR R A BTEIRTE S A IR BR PARIRTE » B AR IRy i R e AR URBH PR IRTE - 21121
RARAEFIRI L 2 HIRIRE AR IRBAREHIIRRE - E IR EI CIR e R EFR BRI -

3.7 PnP/PCI Configurations (PNP/PCI #HKEERF )

Phoenix - AwardBIOS CMOS Setup Utility
PnP/PCI Configurations

Resources Controlled By Auto (ESCD) Item Help
X - IRQ Resources Press Enter
PCI/VGA Pallete Snoop Disbaled

** PCI Express relative items **
Maximum Payload Size 4096

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Resources Controlled By

SaE {5 H n S AT R BE R DU BN i A S SEEHE TR BB -
[Auto(ESCD)] : i e B Bt I HaE

[Manual] : 7¢ "IRQ Resources ; ;&E 8RN IRQ EH -
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- IRQ Resources
% <Enter> $GHEA R THIH ¢
SEMEH H ATRGE S BRI TE [PCI Device] =22 [Reserved] Hrzff—%

Phoenix - AwardBIOS CMOS Setup Utility
IRQ Resources

IRQ-5 assigned to PCI Device Item Help
IRQ-10 assigned to PCI Device
IRQ-11 assigned to PCI Device

tl{-++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

& [E1F] PnP/PCI Configurations (PNP/PCI #HREZFE) TS
PCI/VGA Palette Snoop

SR H AT MPEG ISA/VESA VGA RATLL (BU2 ) B PCI/VGA —EElE -
[Enabled] : MPEG ISA/VESA VGA f1if i PCI/VGA —LESf: -

[Disabled] : MPEG ISA/VESA VGA - R4E8E PCT/VGA — LS -

Maximum Payload Size
It3E H i PCI Express #5117 TLP k& B -
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3.8 PC Health Status (EBS{EELREERT)

Phoenix - AwardBIOS CMOS Setup Utility
PC Health Status

CPU Shutdown Temperature
CPU Warning Temperature
FAN Fail Alarm Selectable
CPU FanEQ Control

- CPU FanEQ Temp. Tolerance
- CPU FanEQ Start Control
- CPU FanEQ Stop Control
SYS FanEQ Control

- SYS FanEQ Reference Temp.
- SYS FanEQ Target Temp.

- SYS FanEQ Temp. Tolerance
- SYS FanEQ Start Control
- SYS FanEQ Stop Control
CPU Temperature

System Temperature

PWM Temperature

CPU FAN Speed

SYS FAN Speed

AUX1 FAN Speed

AUX2 FAN Speed

CPU Core Voltage

DDRII Voltage

DDRII VTT Voltage

PCIE Voltage

ATX +12V

ATX +5V

ATX +3.3V

- CPU FanEQ Target Temperature

90°C/194°F
80°C/176°F
CPUFAN
Enabled
55°C/131°F
5°C/ 41°F

80%

50%
Enabled
System

35°c/ 95°F
5°C/ 41°F

70%

50%
42°C/107°F
30°C/100°F
42°C/107°F

3245 RPM

WUNRORR
o
o
<<<<<<<

Item Help

F7: Optimized Defaults

tl{—++«:Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit Fl:General Help
F5: Previous Values F6: Fail-Safe Defaults

CPU Shutdown Temperature

BESETE AT DU E A H BIRRABRAVIELE - DUBFGE A 2 -

CPU Warning Temperature

ETRTET LS A 5 LS FRUSUNE » 06  UBFRA EERB FRNATS » 7%

HOIEER R S AL

=

FAN Fail Alarm Selectable
A ] S S S AR JE s

CPU FANEQ Control

H

JER

- CPU FanEQ Target Temp.

°

A AT CPU RSB « 35

A AE.

% [Enabled] (RT) I > FYI(AFRIE AR 5 H]

AIHEMLIESE TCPU FanEQ | DRI IR -

SEHUIR

KN9
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- CPU FanEQ Temp. Tolerance

AIEEMLIEE T CPU FanEQ Target Temp. | HYAFHEME]

- CPU FanEQ Start Control

AIEE DR E T TCPUFANL | H2H 1y 4 SHHEUZAHA L IAHuR L -
- CPU FanEQ Stop Control

A H A LAROE B R B asif (XY TCPU FanEQ Target Temp. ; S HA9#fiEhn L. "CPU FanEQ
Temp. Tolerance , 3 H RS (AR5 » b2/ " CPUFANL | 520 R 4 ST S IEGREL -
B PR RS (R R 8 i 2 52 T CPU FanEQ Target Temp. |, SHH A8 {iEIN L " CPU FanEQ Temp.
Tolerance ; I8 HHBIERYIFHE - dEEA(E " CPUFANL | #2508 B9 4 SHIEERHA LSO & " CPU
FanEQ Start Control , % H /s E AUk A - 12715 100% -

¥ FEEAELL 4§t TCPUFANL | B EIRESH LM 3 StHEBAR RRTHEEHINE

SYS FanEQ Control

AP T R SYS EUBIEE - TR [Enabled] [y - TRYIMHIE T RS ARIGIRGE -
- SYS FanEQ Reference Temp.

AT H LA EHEROR S R 25 8l - #8E4T System ; DUk "CPU, -

X EBELOAREECER 3 HNNEERES A RMKIAES B BRI HIThEEMEE - BN :
1. 3§ 3 St ERIERERAEET "SYSFANL | BEEREEL -
2. ¥ TSYSFanEQ Reference Temp. , #t7E:81 System | #pf "CPU, -

- SYS FanEQ Target Temp.

AIEHMLARE T SYS FanEQ  DhRERIE ATIRLAE -

- SYS FanEQ Temp. Tolerance

AIEH M LARE T SYS FanEQ Target Temp. | (Y753EH -

- SYS FanEQ Start Control
AT H DA AT TSYSFANT | 258 1Y 3 SHEUBHAREAAHEDR L -
- SYS FanEQ Stop Control

ARIEH LA EH " SYS FanEQ Reference Temp. | {EJE KA " SYS FanEQ Target Temp. | ZHHIYY
$fE i L T SYS FanEQ Temp. Tolerance | TE H S ERIIRFE - HEE/E " SYSFANL | B20E [ 3 ¢
JAl B AH Y B R P

‘& T SYS FanEQ Reference Temp. | JALE{E R EE 72 T SYS FanEQ Target Temp. | IE H 8%
fEfN_L "SYS FanEQ Temp. Tolerance ; ZE HWSUEYRE(E » HiEE(E T SYSFANT | 208 119 3 $Hl
AR Er T SYS FanEQ Start Control | 35 H v ATa e noMEnHBH G H B ert2] 100% -

FEER - ARiSERHMEERE

&SI H @ YR SR B d DU BRI ~ U . (lRER S E e AR s i\ ) 58 - &
A FR ] e FL e -
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3.9 Load Fail-Safe Defaults (A &-L2 B2 E501E)

SEflEEETEAR A BIOS YR THEE » R IRARE ~ i lRAAmERy RAERLT

3.10 Load Optimized Defaults ( & A R{ELNRETERE )
SEERETE A BIOS HH TR E - WS LS er (e -

3.11 Set Password (3 ERE )

iafEETE A BIOS fHRESRA I A S -

3.12 Save & Exit Setup (BRI fEEPTBERTEE CMOS)

Ta (EE IR T PR HY BIOS e #EH.

3.13 Exit Without Saving ( B#Bi{B F#EEFERFZE CMOS)

B EEEAREHETRCE HLR Y BIOS 3 5%

KN9
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4. BEEFE VAN BRELRIE

Bt BB U A IR ZOURE ) NS B A SRS A R RS THRE AT TR <SRBI =X -
IR R S -

T T EEENTECEL A IR O ) OB RA R - R LU R 22 A B T -
AR BT LU SR BB R AR 8 /7R 4B TAUTORUN | A%< -

abit nForce Series Motherboard
Drivers ‘ Manual Utility ABIT Utility

n¥idia nForce Chipset Driver
Realtek Audio Driver
Cool'n'Quiet Driver

USB 2.0 Driver

-
a blt Browse

cD

o [Drivers] : BhEHERE A BREITE S g H

e [Manual] : BEILERHEA G HFME

o [Utility] @ BErbERHE A NI L LEHEE -

e [ABIT Utility] : B IhaRHEA ABIT MyZBHZEHY A TR =00

o [ Pudittill Browse CD] : TR ILpR I " EREmfE (oA AR LR ) A% -

. [ | Close] : wisstutugpizcsess -
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4.1 nVidia nForce & F{AEEEIFEX
EREEEEREER

1. frReEwEm FEE (MRSt (Driver)] FE4 -

2. ZhEE [nVidia nForce Chipset Driver] - jEHERLL N -

NVIDIA Windows nForce Drivers

Welcome to the InstallShield Wizard for NYIDIA Windows nForce Drivers

3. AR LRI TR RS -
4. EHTETRGREETA AT -
¥ EERESREEERA %574 NVIDIA nForce Chipset FiBIR2 S, -
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4.2 Realtek S EFFE

BERESEEREEE
1. fELdEEHER FEE [BREIEES (Driver)] f4 -
2.  Bi# [Realtek Audio Driver] - B H IR T ¢

Realtek AC'97 Audio Setup (5.23)

‘Welcome to the InstallShield Wizard for Realtek AC'37 Audio

frostellSielt [ <Beck ﬁ

3. GEMURETE BRI RS -
4. EHTEERYGEEREIEARAIEM -

J e |
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4.3 Z28& Cool 'n' Quiet EEFjFE,
BERESEEREEE

1. e T EhE [BEBifEst (Driver)] 154 -
2. Bi# [Cool'n’Quiet Driver] » HFRLI N2 ¢

AMD CPU Driver Setup

Welcome to the AMD CPU Driver
Installation Wizard.

AMD

&y

Athlon

Thiz wizard will install the 32-bit version 1.3.1.0 of the &MD
CPU Diriver,

To continue, click Mexst,

| Mest> |[ Cancel

3. FEIRBEE RIS
4. EREDRTEEEERE AP TER] -
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5. YERMEFETE > SHCRERIG TR TR | (Power Options) » SREEEE T iRy NERIR
&H | (Minimal Power Management)iy & /ﬁ'ﬁ@ﬂ% DU Cool 'n” Quiet & s -

Power Options Properties

Pawer Schemes | Advanced | Hibemate | UPS

" Select the pawer scheme with the most appropriate settings for
L thiz computer, Mote that changing the settings below waill modify
the selected scheme.

Power schemes

Home/Office Desk w

Home/Office Desk.
Portable/Laptop
Presentation

Ture off monitor: After 20 mins £3

Turn off hard disks: Mewver w

System standby: Mewer w
[ Q. l [ Cancel ]

X & Windows 2000 = ME H9/EXX %t - AMD 1y Cool 'n’ Quiet ThEEEER AR ESR
Windows 2000 £; ME A/ Cool 'n’ Quiet #g&r: s 1R+ BIRZ1E (Power Options)
B - WIEThREXERER " BEMER ;| (Automatic Mode) - 401l Cool *n’ Quiet HE#
FIARERRA -

4.4 USB 2.0 EiF)#2z(

¥ 71£ Windows 2000 Service Pack 4 - Windows XP Service Pack 1 FEZBERANIEZE
R MRARKEERSHELN -
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4.5 ABIT EQ (FERSEERDEAIFE)

ABIT EQ J2H1 Universal ABIT firasg it 2 DATEASM RS A AL PRI H T2t - & ] DARE
PEEIRHLER TR - CPU R U d KR CPU R A AE IR S5 B G T 2Rt (8 N\ BRI -

BLESEEARHER
1. {ELSEsEEE AN [ABIT 2= (ABIT Utility)] #54 -
2. Bl [ABITEQ] - REHIRLIT 0 -

InstallShield Wizard X

Welcome to the InstallShield Wizard for ABITEQ
- Y1027

The InstallShisld® ‘wizard will inztall ABITEQ ¥1.0.2.7 on
your computer. To conbinue, click Mest.

Cancel

3. EIRBEE RS
4. EHTEERMEAAEARGIEN -
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5. A Windows TS B CBHA B AEEEI R > CABIT' > “ABIT
EQ" -
6. A ABIT EQ f2:(t% - BRI NET - SRR ~ BURHY  ARAIRL & RIREE -
ABIT EQ
KN9 4-7
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4.6 FlashMenu ( BIOS E£#2x)

ABIT FlashMenu 2435217 Windows {E2E05% BIOS BUHER - MEFA R RMEABARME L -

==
H

T — T BIOS BT » ABIT A FI&hABICER - DUERYFER BIOS HYBEHT -
ERESEEAAES
1. frdersdm FEE [ABIT A0 (ABIT Utility)] FE4 -
2. E [FlashMenu] » KDL N ¢
InstallShield Wizard X
Welcome to the InstallShield Wizard for
- FlashMenu ¥1_40
The InstallShisld® ‘wizard will inztall Flashbdenu 1,40 on
your computer. To conbinue, click Mest.
Cancel
3. GHIREEE LRERTE R -
4. HEPUEERSEARESBGER -
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A Windows TE%1] » B “BARE” 28t > AR “BE” 9> “ABIT” >
“FlashMenu” -

@r Sat Program Access and Defaults

@_\W/ “windowes Catalag

Windows Update

I Accessories
Documents P Futuremark
|3 Gemes
| WWIDIA Carporation
Search » | Startup

-g Internet Explorer
Help and Support %8 MM Explorer
| outlook Express

b

Settings

=T

N
|

&

Rur...
|¢~ Remote Assistance
@& windows Media Player

Log Off Administrator... |
| windows Messenger

Turn Off Computer...

BE 4

wy | Windows XP Professional

[N
)

b RO FlashMenu S - 50T DIEEE [Update From File] ~ [One Click LiveUpdate] =
[LiveUpdate Step by Step] 7t - #FRHY ST Y BIOS -

Update
From File

KN9

4-9

TRy it



4.7 ${{F NVRaid B

AR AR S T B ISR SATA BEEIRE 0 - AT ESS—{7 SATA BBt U -
ST —REERE R ¢

1. frZesdism NEbE [ABIT 220 (ABIT Utility)] £54% -

2. Eh% [Generate NVRaid Floppy Disk] » f&HHER DL N2 :

Raid Floppy Disk Generator

Raid Type:  |midia Raid Floppy Disk

Source CheckSum:  0x5245 BLild

Fleaze S_elect one floppy and inzert a blank
floppy digk. About

Ak ~|

22 IR FT I AT RRRAE - gR [Build ] (75T -
3. BRE[OKI(MEE )oK SATA BB A iy TL /EE -

Message

-
1 ) Build Completely, and Destination checksum: 0x5245

4. BRE[EtLEHEREIE R S E T -

¥ A Windows 2000 {EXFR#R - ENFHARE NVIDIA RAID 2H] - ERRGEEFZ
Service Pack 4 -
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5.

B+ £%

5.1 RMMEHRR (MAERGRIEZE"? )

5.1.

Fl:ﬁ :

1 FjERE

ERERA ST EMIAR R EMFR Al BEYZH EHIRMOSER CMOS &)
1EIS ?

BB BRI R R EA R B R CMOS RYE(T: - G CMOS RYBk#ZSH (Jumper)
FI AR 1-2 AR E 2-3 ik CMOS F I R MG A TO SRR > SRR T
BB I B AR 1-2 GRS RI AL © 5 — KBAR - S I T ARSI A BIOS
IR{EALRIRECEN -

M1 MREREER BIOS HERE T HRNEERSBBEMERRAMEFARE - REXE
37

B ANERZRRITE BIOS s E T iR E e 2 WIS ORI ERIEE - 555 iEkR
CMOS MY L FHET THABRATE(E -

M RAEERERc REEBULRRE RS ?

B DI ) - FRERRT 30 ML ERIMIRRIRFH]

M RTERTE BIOS AERFRENFRENRER AR LMK &8 LA ERREER?
%+ i BIOS Pfful A s HA IR B HYBCE M ECRA MR AD I - Sa ik IO A 8% -
{HF5FF CMOS FUsk kg kR - [EHEEREES TR EAI AT - F AR S RMA SRIETT: -

PAVERALL T =R bR T U e = E RS ¢

AR KRR LERIBERIYIZE OFF (& R IRIEES AR - MIRGE Ben g E IR
RS — DR IE R IR B ER I -
g IR <Insert>HFEiL > [RIRHE TPHIEEDIN - RrFI DIt S A
<Insert>zgt » IRt <Del>Fitk A BIOS 55 o i DAET IEFERIRRE
fEEAGE — IO E AP - AR =R - s TR 2 -

BB 2. RFFEIRGUERS LIERIBARHTIE OFF (i - i ra IR AL BRI A bR » AREE 2R sk
REERES: - FTRHMGR - K CCMOS BERRETHRRAY 1-2 (U 2-3 (7 —708i - LUF
Fx CMOS #okt » [RUETHRR (M - ANikdEE] 1-2 {7 -
R IRERRIRIUES IS - ELIBHIENEIN - PRI SR - 2 <Del>#t
HEA BIOS #iE i RILUETT IEMERIREE
FERITILS B R TR EREBAN - SRETTESERS -
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¥

¥

B3, [P 2 (BRRAEERR CMOS ZoRHEHE TR ERVIRH - [FIIRF A A L It

FRMERER - PRI TR ATX B AR -

1 HRERMSER - RENAA EREAEERE ?
COTER TEAGSRSRE ) ZAT > SRS IR B TR -

RHSTT R LR
AR AR SRR T R S BT R -
HEITEES R L

%

%
%
%

RERFTE LA (B T o BEEs - BORR - RO RO eSS )

TREHTRI -

AR AR - G — iR HAE T/ BRATER | BHEES U LABHR -
AR AR A IR - A T RRAYRC TR BRI -

TSR FIRE A RRE R » R SR B AR DR AR TR -

WA B - SRR BRIA TN 22 AT BRAVST IR S MRS - — {22

—ESEERMBAR TR -

EAERRMERAELRE
AIGRAEE S3 I B R RS T AR 28 A T+ 2 SR DR B P e e R A T
P ARBURRAT ERYE ¢ AR SRR T S © AT

%
%
%

FOHTEAER Y BIOS filiA -
FOHTRT IS E R SRR -
e THERIEAMAE ) AR A UG EE -

D OHMAIRR TR ERE ?
DORRRIRE MRENER T ERSRRE -

W& : FEALHIREE AT -

ETE - AT DUBE B BEEGR -
¥ SR -

% PEAHIRA -

TR ¢ SRR SRR -

P11 : AABXE Ll K, SCSI 29160 il

11 2 : AABXE VM - POST code Hr AF
B3 : AABXE (S3 Mafi{R AR B - )

FERRR © A TRARAIBIRE SRASE -
5] - AABXE REV: 1.00

BIOS jifi4s « #it AT Mt BIOS A (faf LIERAMEE IR A% BIOS fiiA) -

R pRHES ¢ S A LRI AR BRI (MHZ) (AR > & faR)
] : Intel 650 3.4GHz (OC FSB=220MHz)

o
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%

Bt L N NIDER i D it
]+ ZClEHSHE © Kingston (KVR533D2N4/1G)
FUIRMB AR © S A BRIRCIR T s A -

] : 512M* 4PCS

FOIEREERE © # A BIOS RE FIURCIEHERE

il © GUREHERRIR © 2.5-3-3-7 @533MHz

RN REA - 5 T USRI > 5T SR BN A -

-y SR YN CNIbE N T B
# : ATI RADEON X850 XT PE

FEREEREIRE AR © #EABHEUR - REREIFE A -
] = Catalyst 5.12V

EIRIUEREGER « S ALTERI SRR R A5 -
TEVRBEREAR LB ¢ A SEAT AR IR L ME AR LB -

FEFEEE © AR - HAS LUK B8 - SERARERE 82 {F IDE (Master 52 Slave )
T G SATA #fl I > LUk RAID Z3FliRTE -

5] 1 : WD Caviar WD600 60GB (Hif#{F IDE2 master $#58 ) » Maxtor DiamondMax 10
SATA 300GB (Eif(r SATA 3 £45H )

51 2 : Maxtor DiamondMax 10 SATA 300GB *2 (;#if{F SATA 3 - SATA4RAID 1)

JEEBEEE ¢ G ARSI RS B -SRI S HiEEAE IDE (Master 502
Slave) =i SATA ¥55H [ -

FAMSERE - AR A A 2 — sk USB 2 SEEa ity - a0
RIS MR AR - FERAE EATHI IR B USB 22 it -
Il : AHA 29160 (Ze#f4 PCI 2 ##if# ) > Sandisk Cruzer mini 256MB USB Flash-disk

PERFM © TR SR S EE S IRA -
51 = Microsoft Windows XP SP2 =kl -
%l = Microsoft Media Center Edition 2005 #3Zfi

FIRERGI © Rt Rifae e R 2 AR R AR RERIRS R R B A AR TR

B -

BRI S I e S T O RIS BT & oy - SR e [ K el B | U= S et =E e p S
( http://www.abit.com.tw/page/en/contact/technical.php) -

DOEBIRE TR P AR ERRBENERERET RMAERF?

DR F SRR A A R > SR UREEI R A WA ISR - SRRy
RMA Hhu 0B -
( http://www?2.abit.com.tw/page/en/contact/index.php?pFUN KEY=18000&pTITLE IMG)
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5.1.2 HEfif < TR

HhiE :

BB

I

2

ES

TR -

BIOS hiAs :

FRORERIRER

e
&

¢l

SRS -

e

i

o

e
&

Cl

fein

o

RIEERE :

R

BN REREEIRA

BIRUIEIRSUER

BREESRE

HEEE

SBRE

HithE -

TERH

AR -
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5.1.3 Universal ABIT #4571

i)

AT
RENEERNERAT
HALHIPIEE 114 i 323 5%
Fafh © 886-2-8751-3380

{457 : 886-2-8751-3381

7% © sales@abit.com.tw
TS © market@abit.com.tw

al

Jv3EM ~ =M
Universal ABIT (USA) Corporation

2901 Bayview Drive, Fremont, CA 94538,
U.S.A.

#ah ¢ 1-510-623-0500

{85 : 1-510-623-1092

444l : http://www.abit-usa.com
H7TEW ¢ ventas@abit-usa.com
RMA 1.0, © http://rma.abit-usa.com

B - - BEEL ~ RINAIE ~ HTE
KRiE ~ RRARFD  FLEnE - ERMLE -
BHIE - fngit/en

Universal ABIT Austria Computer
GmbH

Schmalbachstrasse 5, A-2201 Gerasdorf /
Wien, Austria

BTG ¢ 43-1-7346709

{HHE : 43-1-7346713

I4& « office@abit-austria.at

#44l - http://www.abit-austria.at

wE - FWE
Universal ABIT UK Corporation

Unit 3, 24-26 Boulton Road, Stevenage,
Herts SG1 4QX, U.K.

T3 1 44-1438-228888
{41  44-1438-226333

L&

Universal ABIT (Shanghai) Co. Ltd.

LR B 1089 SRS KE 19 2
(4 200030)

HiE: (86-21) 54102211

fE3: (86-21) 54104791

Mtik:  http://www.abit.com.cn

B B =R (8 ~ LA BRE) -
EE ~ AR -~ mS - AES - HE -~
R - W BT Wt

Universal ABIT NL B.V.

Jan van Riebeeckweg 15, 5928LG, Venlo,
The Netherlands

FEEE © 31-77-3204428
fHE : 31-77-3204420

R

Universal ABIT Poland (f{F151)
Strzegomska 310/2, 54-432 Wroclaw
BEaE  +48-71-718-12-39

%% + Grzegorz Morgiel

Russia
Universal ABIT Russia ({0 R)

4% © info@abit.ru
#auk - www.abit.ru

TEHE
Universal ABIT Turkey ({0 E)
E2E 1 90 532 211 6860
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